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1 Objective of this Document 

1.1 The Purpose of this Document 

This document provides an overview of the new features available in the OX  
Documents v7.8.3 release. For the first time this release of OX Documents  
includes OX Presentation, a cloud based presentation editor that can work with 
Microsoft PowerPoint documents in a lossless way. 

The objective of this document is to help Open-Xchange customers and partners  
understand the benefits and features of OX Presentation and the other OX 
Documents improvements. 
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2 Introducing OX Presentation 

2.1 What is OX Presentation? 

OX Presentation is a cloud based presentation editor used to create slides with 
words, shapes, pictures, tables, footer and other elements that tell a story or help 
support a speech or presentation of information.  

OX Presentation can work with Microsoft PowerPoint documents in a lossless 
way. Users can edit shared presentations on various devices.  

2.2 Who should use OX Presentation? 

When students and teachers have to deliver material in presentation format or 
business users want to pitch an idea or product or if users work with a team who 
all use different platforms, OX Presentation is the right choice for consumers and 
businesses. 

2.3 Key Benefits of OX Presentation 

The key benefits of OX Presentation are: 

• Online presentation editor – works on all platforms and devices  
• Round-trip editing – non-destructive support for PowerPoint files (2007 

and later) 
• Work with less effort – the concept of master and layout slides allows  

users to make changes once and they will be applied to all slides 
automatically 

• Teamwork – share presentations with other users without worrying 
anymore about which product or operating system the user has 

2.4 Key Focus Areas of OX Presentation 

This first release of OX Presentation focusses on round-trip editing, working with 
text frames, bullets and numbering, support for master slides, inserting shapes, 
aligning and reordering objects, multi-selection, group handling and teamwork.  

Not in scope in this release is creating SmartArts, charts, comments, handouts, 
animations and transitions, videos and audio files.  
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2.4.1 Round-trip Editing 

Round-trip editing allows a seamless collaboration with Microsoft PowerPoint  
users. OX Presentation can open existing PowerPoint files even if they contain an 
element that is not recognized. For such an element OX Presentation will create 
a placeholder. Users can now edit the presentation. When they have finished 
their work, the presentation can be opened in PowerPoint and the document will 
be intact, with the new edits visible together with the original elements and 
formatting.  

2.4.2 Support for Master and Layout Slides 

The usage of master and layout slides can be a big time saver. A master slide 
can propagate a general layout through all the slides used in a presentation. That 
can include background, font formatting, dates, slide numbers and images, like 
logos. That way the layout of the presentation can be modified much faster than 
doing it slide by slide (see chapter 3.4). 

2.4.3 Working with Text in Frames 

Text is probably the most important element on a slide. Therefore OX 
Presentation offers powerful features for working with text frames including 
different kind of attributes as well as bullets and numbering. Text frames can be 
positioned anywhere on a slide and allow a number of Autofit options (see 
chapter 3.5.2). 

2.4.4 Shapes 

Shapes are ready-to-use objects in different forms, such as lines, squares, 
circles, etc. Shapes can help to create better presentations and can be 
customized in a number of ways (fill or outline). They also can contain text, text 
formatting, bullets and numbering, etc. (see chapter 3.6). 

2.4.5 Aligning and reordering objects 

The placement of objects on a slide can make so much difference and plays an 
important role in making slides look beautiful. OX Presentation allows users to 
change the order in which each item appears on a slide and the position of an 
object in relation to itself and other objects (see chapter 3.6.3 and 3.6.4). 
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2.4.6 Group handling 

Grouping objects allow users to save time because they can move or change 
these objects as a single unit instead of moving them individually. And  
users don’t need to spend time reselecting all the objects, if they need to move 
them again. Grouping is also useful for creating complex slides (see chapter 
3.6.5). 

2.4.7 Teamwork 

OX Presentation simplifies teamwork by letting users join forces to create 
presentations in real time (see chapter 3.10).  
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3 Key Features of OX Presentation 

This chapter describes the main features of OX Presentation. As OX Presentation 
offers a number of features that are already known from OX Text and OX 
Spreadsheet such as text formatting and file handling, this sections focusses on 
functions and concepts that are specific to OX Presentation.  

3.1 Using Templates 

OX Presentation comes with a number of pre-defined presentation templates. 
These templates are an easy to use starting point for creating a new presentation.  

 
Templates in OX Presentation 

 

Users can select an existing presentation from the recent documents list or click a 
template to create a new presentation based on the selected template. It is also 
possible to create own templates, that will automatically show up in the first line of 
this template view. In addition OX Presentation supports templates created in 
PowerPoint (see chapter 3.3 “Placeholder”). In the following examples the “blank 
presentation” is used. 
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3.2 Slide View 

As with many presentation editors users have a main slide view and a slide pane 
with thumbnails of all slides in a presentation. These thumbnails allow an easy 
and fast navigation through the presentation. 

 
Normal slide view 

 

This view is the main editing view, where users write and design their 
presentations.  
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3.2.1 Adding Text  

To add text to a slide the user just clicks the text placeholder. The placeholder 
dummy text (“Click to add title”) will disappear when the user starts typing in the 
box.  

 
Adding text to placeholder 

 

Placeholder text is not displayed in the slide pane but only on the slide. If the 
users’ text is deleted then the placeholder text will reappear. 

Please note: The default placeholder text can also be changed from within the 
Slide Master View. This is helpful when users create own templates and want to 
describe what should be entered into the placeholder.  

3.2.2 Adding Slide 

A new slide can be added via the slide pane context menu or the “+ Slide” button. 
The new slide will be inserted behind the selected slide. Clicking the “+ Slide” 
button always creates a content slide based on the selected slide. If a 
presentation has just one title slide and a new slide is added using the “+ Slide” 
button then the new slide is a content slide and not a title slide. 

Users can also insert a slide with a different layout by clicking the dropdown  
button. 
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Adding a slide with a different layout 

3.2.3 Changing a Layout 

A slide appearance can be changed quickly by applying a different layout. Click 
“Layout” or right-click the slide and choose “Change layout”. Click the layout that 
fits best to the required content. 

 
Changing a layout of a slide 
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3.2.4 Slide Pane 

The slide pane on the left side of the screen also allows user to restructure a 
presentation. Slides can be moved around via drag & drop and reordered easily. 
Dragging a slide creates a black bar that indicates where the slide can be 
dropped. 

 

 

 

 

 

  

 

 
Sorting and hiding slides with black background 

Slides can also be duplicated, deleted or hidden. Hidden slides do have a special 
symbol in the upper left corner and are greyed out. They can be edited like all 
other slides, but won’t be shown when giving a presentation.  

3.2.5 Resizing the Slide View 

Presentation editors are often used on different output devices with different 
resolutions. So the creation process is often done on a large monitor but fine-
tuning or last minute changes are often done on a laptop with a different screen 
resolution.  

To switch easily from one resolution to another without manual adjustments, OX 
Presentation allows resizing the user interface proportionally. This means that the 
slide view and the slide pane are resized at the same time and at the same ratio. 
The user can continue working without manually changing the size of each of 
those user interface elements individually. 

Drop target 

Hidden slide 
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Resizing from full HD to smaller laptop screen 

3.2.6 Context Menus 

Different context menus are available for the slide view, the slide pane and all 
selected objects to allow quick access to possible actions. 

 
Context menu in slide 

 
Context menu in slide pane 
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3.2.7 Task-oriented User Interface 

The user interface is task-oriented and gives users the right tools if they need 
them. For example, if the user inserts a text frame via the “Insert” tab, the user 
interface automatically switches to the “Shape” tab to offer all options to format 
the text frame. So the user can decide to start typing text or formatting the text 
frame without touching the user interface again. 

3.3 Placeholder 

OX Presentation can work with templates created in PowerPoint. Templates can 
contain a number of preformatted placeholders. A placeholder is a box with 
dotted borders that users insert information into. OX Presentation supports 
individual placeholders for text, image, table and a generic placeholder that 
combines text, image and table. 

Please note: PowerPoint templates can also contain placeholders for a chart, 
SmartArt and media clip, which are not supported yet in OX Presentation. 

Inside the borders of the placeholder, icons represent the types of data that can 
be added. A placeholder can also contain a dummy text that explains what the 
user should do.  

 
Universal placeholder for text, image or table 

If the user clicks the dummy text, the text will disappear and the user is allowed to 
type in custom text. If the user deletes this custom text, the dummy text will 
reappear again. Clicking the image icon (“Insert image”) opens the “Insert image” 
dialog to import an image. Images can also be dragged & dropped from the 
Desktop or a website to an image placeholder. Clicking the table icon inserts a 
table at the position of the placeholder. 
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What is the advantage of working with placeholders? OX Presentation offers 
multiple ways to add data to presentations. For example, text frames serve the 
same purpose as text placeholders. The advantage of placeholders is, that the 
content (text, image or table) is automatically formatted and positioned exactly at 
the reserved space. 

Please note: Inserting new placeholders is not supported yet in OX Presentation. 

3.4 Working with Slide Master and Slide Layouts 

Inconsistencies in a presentation, like different font sizes and styles, diverse 
layouts or dissimilar backgrounds across successive slides do not look 
professional and will make an audience uncomfortable. The slide master feature 
in OX Presentation allows users to create good looking presentations in less time 
with less effort. Presentation designers can make global changes to many or all of 
the slides of a presentation without having to make these changes to individual 
slides. The slide master influences the layouts of all slides in a presentation. 

The most common use cases for the slide master are: 

• Changing the font and styles for every slide 
• Add an image or logo to every slide 
• Add a footer or date to every slide 

3.4.1 Modify Slide Master 

To modify the slide master, click “View master” in the “View” menu or “Edit 
master” in the “Slide” tab. The slide master is the largest slide at the top of the 
slide pane on the left side of the screen. Related slide layouts are positioned 
beneath the slide master.  
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Master view with mater slide (1) and slide layouts (2) 

A bubble help in the slide pane shows the slide numbers in the presentation 
which are based on the selected slide master or layout.  

 
Bubble help with slide numbers  

If users add new text, images or other objects to a master, these objects become 
part of the slide background and appear on every slide in the presentation that is 
based on that master. These objects are not editable in the normal view. Only 
placeholders on the slide master are editable in the normal view. That way users 
working in the normal view can not accidently delete, or make changes to, the 
layout of the presentation. 

1 

2 
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Because working on a master slide affects the look of the entire presentation,  
users should always be aware when they are working in the master view. 
Therefore the master view has an additional notification text below the slide: 

 
Notification about the master view  

3.4.2 Modify Slide Layout 

Slide layouts are different arrangements of placeholders that are associated with 
a given slide master. When users make changes to the layout of a presentation, 
the majority of these changes will most likely be to the different slide layouts 
related to the master. Users will pick the layouts that best matches their slide 
content and can change the layouts as often as they want.  

Anything about a layout can be changed. Users can copy, remove, or resize 
placeholders, and make changes to fonts, colors and other elements. If a layout 
that is used in a presentation is changed, all slides using this layout will be 
changed automatically, as long as no other changes (i.e. size and position) have 
been done to the placeholder in the normal view earlier.  

If the placeholders are changed in normal view (hard formatting) and then other 
layout changes are done on the layout slide in the master view, the placeholders 
in the normal view keep the original appearance and are not updated 
automatically. Every slide that is added after that will be based on this layout and 
will reflect the changed look of the layout.  

When two or more completely different styles (backgrounds, colors, fonts) are 
needed in one presentation, it is also possible to work with two or more slide  
master.  

3.4.3 Changing Slide Master Background 

OX Presentation allows users to use different fill options as slide backgrounds, 
such as no background, color fill, and an image fill. In addition “Transparency” 
allows users to change the transparency of the color or image.  
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Background dialog  

The “Hide background graphics” option is helpful if all objects from the master or 
layout slide should be hidden for the selected slide.  

Changing the background for slides should be done in the slide master view 
rather than in the normal view. OX Presentation uses the background specified in 
the master for all slides unless the user overrides the background by formatting 
the background of any slide in the normal view.  

Please note: OX Presentation can also display gradient and texture fill including 
tiling options created in PowerPoint. Note that creating and changing those fill 
options is planned for future releases. 

 
Gradients on background and in shapes  
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3.5 Working with Text 

Text is probably the most important element on a slide. In addition to text 
placeholders, you can add almost any number of text frames to a slide. With text 
frames users have more flexibility over positioning the text and can add text 
outside placeholders. Click “Text frame” in the “Insert” tab, click and then drag the 
mouse to draw a frame and start typing text then.  

Please note: If you click outside the text frame before typing in it, the frame 
disappears. However, the frame is still there, but invisible. This might cause 
problems or confusion later. So if you “lose” a text frame, it might be helpful to 
undo the frame and start over.  

When the initial text frame is dragged out, it retains its width, but the height 
contracts automatically to the height of one line of text. When multiple lines are 
typed, the height will adjust automatically to fit, but the width of the text frame will 
remain fixed. 

3.5.1 Formatting Text 

Text in OX Presentation can have all kinds of formatting:  

• Text attributes 

• Horizontal and vertical alignment 

• Line and paragraph spacing  

• Bullets and numbering 

Note, bullets or numberings with an empty paragraph are removed. 

3.5.2 Text Frame Options  

When a text frame is selected there are three Autofit options available in the 
“Shape” tab to work with text frames. You can only select one of these options, as 
explained below: 
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1. Autofit – Off: Text does not automatically fit within the 
selected text frame or placeholder. This option lets the user 
have complete control over the location and size of a text 
frame. OX Presentation will not automatically reflow your text 
or increase the size of the text frame.  

2. Autofit – Shrink text: Text will always fit in the text frame by 
reducing the text’s font size automatically. So text 
automatically shrinks as much as is needed to allow it to fit, 
which is very useful to prevent text from being truncated. 

3. Autofit – Resize frame: This is the default option and retains 
the text size but increases the size of the text frame or 
placeholder. Extra text can reflow itself within the resized text 
frame or placeholder. Please note: Even if the “Lock ratio” 
checkbox is selected, the text frame will only resize itself 
vertically rather than both vertically and horizontally.  

4. Resize – Look ratio: With this check-box any change in 
height reflects a proportionate change in the width, and vice 
versa. This is important for resizing images to prevent 
stretching and to keep a picture in proportion.  

3.6 Shapes 

Shapes are predefined objects like circles, squares, arrows, stars and lines. OX 
Presentation has a gallery of shapes to choose from. Shapes can help to create 
better presentations.  

Autofit options 
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Shape gallery  

Shapes are grouped in the following types: 

• Lines 

• Basic shapes 

• Rectangles 

• Block arrows 

• Flow charts 

• Stars and banners 

• Equation 

In addition to these shape types there is the “Recently used” section to give quick 
access to the shapes that were used recently.  

3.6.1 Text within Shapes 

A shape can also contain text, just start typing immediately after a shape is drawn 
and the text shows up within the shape. This text can also be formatted with all 
options in the “Format” toolbar. 
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Shape with text 

3.6.2 Border Style, Border Color and Background Color 

Whenever a new shape is inserted into an OX Presentation slide, it is filled with a 
solid color and has a border by default. The style and color of the border as well 
as the background color can be changed easily. It is also possible to remove the 
border or background color. Please make sure not to do both, the border and the 
background color, because then the shape will no longer be visible. 

 
Change background color of shape  

Please note: The “Shape” tab is a contextual tab that is not visible all the time. It 
only appears when a shape is selected.  

Some shapes use more than one color. These colors are based on a color theme 
so if one color is changed, the other colors will also change automatically. 
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Shapes with different color themes  

3.6.3 Arrange Shapes 

Shapes and also other objects like placeholders can be stacked in layers, so that 
one item appears in front of another. The order in which each item appears on a 
slide can be changed with the “Arrange” menu. 

 
Reorder and rotate options 

The position of a shape, text frame or picture item can also be changed by 
rotating or flipping it. 

It is also possible to rotate an object to any angle by clicking and dragging the 
rotation handle at the top of the object. To limit the rotation to 15-degree steps, 
users can hold the Shift key while dragging the rotation handle. When multiple 
shapes are rotated, they do not rotate as a group, but instead each shape rotates 
around its own center. 
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Rotate multiple shapes 

3.6.4 Align and Distribute Shapes 

The placement of objects on a slide can make so much difference and plays an 
important role in making slides look aesthetically pleasing. Therefore OX 
Presentation offers the following options to position an object on a slide in relation 
to itself and other objects:  

 
Align and distribute options 

If objects should be evenly spaced from each other (at least 3 objects must be 
selected), then select “Distribute horizontally among objects” or “Distribute 
vertically among objects”. 
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Evenly spaced shapes 

The shapes towards the left are not distributed equally whereas the shapes 
towards the right are. 

3.6.5 Group and Ungroup Shapes 

Grouping allows users to combine two or more objects into a single grouped 
object that can more easily be managed, resized or moved around. It is often 
easier this way than to select all of the objects each time they need moving. 
Grouping is also useful for creating complex slides because it enables the user to 
work on one part of the slide, group it, and then work on the next part without 
disturbing the part that was already grouped. 

Choose all objects that should be included in the group and then right-click on 
one of the selected objects and then select “Group” from the context menu, or 
select “Group” in the “Drawing” tab. The grouped objects will then be in a single 
box with sizing handles around the entire group. Now all of the objects can be 
moved or resized together. 

 
Three selected images  

 
 
 

 
 
Grouped images 
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Only grouped objects can be ungrouped which is the opposite of grouping and 
breaks down a grouped object back into their individual pieces.  

Please note: “Group” and “Ungroup” are also available from another contextual 
tab called “Drawing”, which shows up when more than one object is selected.  

 
Drawing tools 

3.6.6 Duplicate Shapes quickly 

Shapes and all other objects in OX Presentation can be duplicated using the 
traditional copy and paste method. There is also a way to quickly duplicate any 
object without using as many mouse clicks:  

• Select the object that you want to duplicate 

• Press the CTRL key for the copy cursor (on Mac        and Windows      ), 
click and drag the object to the new location to create a copy 

 
Duplicate shape by dragging 

It is also possible to select multiple objects and CTRL drag to create copies of all 
selected objects at one go. 
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3.7 Tables 

Inserting a table in OX Presentation is done via the “Insert” tab. The table grid 
allows users to highlight the number of columns and rows while moving the 
cursor.  

 
Inserting a table 

The “Table” toolbar offers options to add or delete columns and rows.  

 
Table options  

Tip: To quickly insert a new row at the end of a table, click inside the last cell of 
the last row, and press TAB. 

3.7.1 Table Styles 

OX Presentation also supports pre-designed table styles that add borders, 
shading, and text formatting.  

 
Table styles 
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If a table uses a different PowerPoint theme, this theme will also be available in 
the table style section of OX Presentation.  

3.7.2 Borders 

Adding a border to a table, shape, picture or text frame allows users to make 
those elements stand out. OX Presentation offers a number of different border 
styles in the “Table” tab. It is also possible to change the border width.  

 
Border options 

3.7.3 Resize a Table 

A whole table can easily be resized to improve readability or the visual effect of a 
slide. Click and drag the sizing handle on a table border to make the table larger 
or smaller. To maintain the same ratio between the height and width of the table, 
users can press and hold SHIFT while resizing the table.  
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Resizing tables 

3.8 Adding a Footer or Field 

OX Presentation can display footer elements that will appear on all slides in a 
presentation. For example, users can add the date and time, the name of the 
presentation or the slide number. The best place for adding footers is the slide 
master (see chapter 3.4) as all slides that are based on that particular master will 
display the footers. 

3.8.1 Insert Footer 

To add elements that will appear as a footer at the bottom of all slides, use the 
“Insert” tab and click “Footer”. 

 
Footer options 

• Click the “Date and time” checkbox and select a fixed date, or add a date 
and time that is updated each time that the presentation is opened 
(“Update automatically”). The dropdown offers a number of date and time 
formats to choose from. 
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• Click the footer check box, and type in the text that should appear in the 
center-bottom of the slide.  

• Click “Slide number” to add a slide number in the right-bottom of the slide 

The footer will be applied to the current slide by clicking “Apply” or to all slides of 
the presentation by clicking “Apply to all”. 

3.8.2 Insert Field 

OX Presentation also offers an even more flexible way to add the slide number or 
a date to a slide. This is helpful for example if the date should be in a different 
format or if the slide number should not be in the footer but somewhere else on 
the slide.  

Use the “Insert” tab and click “Field”. 

 
Insert field 

If “Slide number” is selected, a new text frame with the current slide number is 
added to the slide. As this text frame is not placed on the slide master, it can be 
positioned anywhere on the slide and formatted. This slide number is now only 
visible on this one slide. All other slides in this presentation do not have this text 
frame.  

 

 
Slide number in text frame 

The same applies to the second option “Date and time”. The user can select a 
predefined format and again decide whether the date should update 
automatically.  
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Date and time options 

3.9 Slide Settings and Slide Size 

To change the slide size and orientation or to define a custom slide size select 
the slide settings in the “File” tab. 

 
Slide settings 

It is also possible to change the slide size from widescreen (16:9) to standard 
(4:3), or from standard to widescreen. OX Presentation will automatically scale 
the content to a larger or smaller slide size. 
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3.10 Teamwork 

As in OX Text and OX Spreadsheet, it is also possible to work collaboratively on 
presentations in OX Presentation. This allows better teamwork, less iterations of 
presentation and avoids sending presentations back and forth via email. 

When users work together on the same document, they can see whatever the 
other user is editing or selecting. The name of the user is displayed in a bright 
color at whatever point the user is editing or selecting. 

To avoid confusion and conflicting changes overriding each other, only one user 
has edit rights at any one time. Edit rights can be transferred at any time to any 
user.  

 
Edit rights are transferred to the user 

Users with read-only access cannot edit the document but can do selections in 
the document, which can be seen by all other collaborators. 

 
Two users collaborating 
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3.11 Guided Tour 

A guided tour helps first-time users to get familiar with the most important 
functions and concepts of OX Presentation. This guided tour can be started in the 
Settings menu. 

 
Learn about OX Presentation 

3.12 Presenting 

Once the presentation is done, the slides can be presented either to a local or 
remote audience. Presenting can be initiated by clicking “Present” in the toolbar.  

 
Presenting with OX Presentation 

Clicking “Present” starts the Presenter app with the current presentation. The 
Presenter app allows users to navigate through the slides horizontally via 
thumbnails, navigation buttons, keyboard shortcuts or clicking the slide. The user 
can also zoom in and out and start a presentation. 

The user can now decide to start a local presentation, which allows the 
presentation to be viewed in fullscreen. If there are remote attendees, who want 
to join the presentation, the remote presentation mode can be used.  

Starting a remote presentation switches to the Presenter view, which shows the 
current and the next slide. This view also allows you to switch to full screen mode 
and to end or pause the presentation. With the navigation bar at the bottom, 
users can jump directly to a slide or check who is participating in the presentation. 
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Presenting to a remote audience 

All remote participants who want to join the presentation, and have this URL 
open, receive a notification that the presentation has started and that they now 
can join. Joining the presentation switches the view to full screen. All remote 
participants will now see the same slide and navigation in real time, and can 
follow along.  
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4 General Improvements  

4.1 Support for Encrypted Files (OX Guard) 

OX Documents now has support for OX Guard encrypted documents. Encrypted 
documents can be edited directly without the need for users to decrypt the 
document first and then encrypt it after editing. All versions edited with OX 
Documents are also encrypted automatically. 

Further information can be found in the Product Guide for OX Guard v2.6.0: 

http://software.open-xchange.com/products/guard/doc/OX_Guard_Product_Guide_2_6_0.pdf 

4.2 Support for Web Fonts Calibri and Cambria 

Microsoft introduced new default fonts with MS Office 2007, Calibri and Cambria, 
which are also part of Microsoft Windows since the release of Windows Vista. 
Most office documents use these fonts. If a document using Calibri and Cambria 
is edited with OX Documents, the document is rendered correctly as long as 
these fonts are installed on the system. If this is not the case, i.e. on Linux or 
mobile systems, the browser uses a replacement font, which means the 
document layout might change.  

To allow original rendering of office documents without Calibri and Cambria 
Google created two metric-compatible web fonts Carlito and Caladea. OX 
Documents is now using these two web fonts whenever Calibri and Cambria are 
not available in the browser.  
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5 OX Text  

5.1 Shapes in OX Text 

Shapes in documents are now not only displayed in OX Text, they can also be 
edited. Please note: Inserting new shapes will be supported in one of the next 
versions of OX Text. 

 
View and edit shapes in OX Text 

 

6 OX Spreadsheet  

6.1 Support for Array/Matrix Formulas 

An array or matrix formula is a special formula that operates on a range of values.  
An array is simply a rectangular block (rows and columns) of information that OX 
Spreadsheet can manipulate in a formula.  

The benefit of using array formulas is that it can combine formulas and save room 
in a spreadsheet so this allows to analyze even more data in a smaller space. 
Here are a few examples for using array formulas: 
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• Do multiple sums simultaneously 

• Counting unique values 

• Counting values based on multiple criteria 

There are two flavors of array formulas:  

1. Single value result array formulas 
The result calculated from arrays is a single value. 

2. Formulas that return arrays 
This formula returns an array of numbers as its result. 

Example for #2: The two yellow arrays are added. The result is in the orange  
array.  

 
Add the two yellow arrays 

When entering an array formula, users need to press CTRL+SHIFT+ENTER to 
copy the formula to every cell in the array range. The formula in the screenshot in 
H2:I3 is: =B2:C3+E2:F3 

6.1.1 Enter a New Array/Matrix Formula 

In order to be understood as an array formula, a formula must be input in the 
following way: 

• Select the range of cells that you want to enter your array formula into 

• Type an array formula into the first cell that returns an array result 

• Press CTRL+SHIFT+ENTER. This fills the cell range starting with the 
edited cell with an array formula with the exact size of the matrix result 

6.1.2 Edit an Array/Matrix Formula 

OX Spreadsheet does not allow to edit just one part of a range of cells that 
contain an array formula, as the cells work together as a group. 
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• Edit any single cell of an existing matrix formula 

• Press CTRL+SHIFT+ENTER to fill the entire cell range with the formula 

6.1.3 Restrictions 

• The size of an array formula is restricted to 10.000 elements. 

• A user cannot insert/delete columns or rows in the middle of a matrix 
formula (e.g. insert new column between A and B) 

• Single cells inside an array formula cannot be changed  

• New array formulas cannot overlap with existing array formulas 

6.2 Custom Sort   

OX Spreadsheets now provides an improvement in the sort functionality. User 
can now sort by more than one column by adding levels of sorting criteria.  

	
Add more sort criteria 

	


